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1. Introduction 
I first began learning laptop computer keystrokes when I purchased my first laptop 

computer, used from a friend in 1995. The mousepad was broken, so I had no way of pointing 
and clicking on the various menu items within Word or any other apps for that matter. Window 
management was also an issue, so I was forced to learn some of the subtler keystroke 
combinations that would give me access to the various applications on my laptop. 

Looking forward to what might be next with report formatting, it could be that there are 
some killer AI apps on the near horizon that will obviate this mini-course in formatting. For now 
though, if you’re like me and still use your fingers for typing and your brain for thinking, I hope 
you find this guide to be useful. Much of the content I picked up along the way as a graduate 
student and post-doctoral fellow at the University of Michigan and while on the engineering 
faculty of Drexel University. 

2. Nomenclature 
As the primary intent of this document is to provide technical instruction, I include a 

nomenclature section here as a reference for the various symbols and fonts used throughout 
the book. The format of the font in this paragraph is “body.” After finishing this mini-course you 
will be able to define and use your own styles. See the Styles: body, body_no_indent, figure, 
caption, quote, heading section in the Pro Formatting chapter. 

In the Heading of this section, you can see that I’ve used a blue Calibri Light as my font, 
which happens to be the default for MS Word. I have also enumerated the chapter headings for 
easier referencing. 

There are two typical means formatting and cursor management: one way is to navigate a 
set of menus that otherwise would be navigated by mouse. As a simple example if we wanted 
to insert a picture into this document, we could use the mouse to navigate the menus. As an 
alternative, we could strike the key sequence ALT→N→P→D. Note that I’ve used the → symbol 
to denote a strike and release, such that only one key is depressed at a time, namely the four 
keys, ALT, N, P, and D.  

There are other keystrokes, such as that for superscripting where three keys must be all 
depressed, for such sequences, I will use CTRL SHIFT + , where there is simply a space in 
between the key symbols. 

Note that I also use a combination of gray highlighting and Courier New 
font to distinguish keystrokes from the rest of the prose in this book. 

 



  Page 2 of 25 

3. Essential Key Strokes1 
This chapter introduces the reader to several keystrokes that eliminate or greatly reduce 

the need to use your computer’s mouse or mousepad. For report authors who a managing 
several apps, I also include a brief windows management chapter: Chapter  9 Windows 
Management, page 20. 

ALT - TAB to toggle among running applications 

Note that with ALT TAB, you first depress the ALT key with your left thumb, then while 
holding down the ALT key, you hit the TAB key with your favorite left finger Figure 1.  

 
Figure 1. As you hit the TAB key, running windows become highlighted. Release the ALT key when the 
window you desire is highlighted. 

So, for example, to get to the fifth window in the sequence you would hit ALT→TAB TAB 
TAB TAB TAB 

Everyday Essentials: CTRL I, CTRL U, CTRL B 

If you’ve ever explored the control key before, you are likely familiar with these three 
keystrokes that create underlined CTRL U, bold, CTRL B, or italics, CTRL I. 

 
1 https://youtu.be/69fPof-ZTnU  

https://youtu.be/69fPof-ZTnU
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4. Good Habits 

Save your document with CTRL S 

While sitting at my UNIX cluster and hopping back and forth to Macintosh computers for 
word processing in the early 2000’s, my lab partners and I would get way into pumping out 
technical prose for publication in peer-reviewed scientific journals. In fact, we would get so 
deeply into our writing, and fill those machines up with some much dense complex content, 
that we would overwhelm their RAM and completely for get to save our precious precious 
work. After screaming out loud to each other in despair enough times, we eventually learned 
the secret: develop a nervous twitch of hitting every time we even glanced away from the 
screen, or even every time after hitting the . key. This nervous twitch was to hit CTRL S. It’s a 
pretty simple keystroke, in fact one of the most ergonomically favorable, so do it a few times 
now with your left pinky and left index finger. 

Select all of the text in your document with CTRL A 

Let’s say you have a document and the whole thing is in ten-point font, and you want to 
print a copy for a friend who prefers to read documents in fourteen-point font. Rather than 
trying to scroll through the entire document, or edit the document paragraph-by-paragraph, 
instead, hit CTRL A and select all of the font, then apply whatever formatting change you 
wanted to the entire document. You will also find CTRL A handy when updating your cross 
references and table of contents with a single click of the mouse as we will see in Chapter 9 
Cleaning It UP, page 17.    

Electronic Cut and paste with CTRL X and CTRL V 

You’ve crafted a perfect paragraph in your expert witness report, but then realize that 
perhaps it’s too technical for the main body of the report. You decide to create an appendix for 
this well-crafted but highly technical creation. First select the text with the skills learned from 
Chapter 5: Built for Speed – Quit Mousing Around!, page 5. Once the appropriate text is 
selected, hit CTRL X. Next place your cursor where you want the cut text to appear and hit 
CTRL V. This combination of keystrokes is also particularly handy when hopping around 
among different document types, and for copying an pasting difficult-to-remember passwords. 

Oops I Did it Again! Instantly fix mistakes with CTRL Z (Undo) 

You’re typing merrily along when your finger slips and deletes an entire paragraph or some 
other weird, unexpected and annoying thing happens to your report. Do not fret. Do not panic. 
Do not start hitting random keys. Focus. Focus your attention on hitting the CTRL Z key 
combination. Your accidentally deleted paragraphs reappears just as it was. Now hit CTRL S, 
take a deep breath, a sip of coffee, and get back to work. 
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Don’t be a Computer, Use Your Computer. Redo Repetitive tasks with CTRL Y 

Let’s say you have just applied a fancy style to some font in one of your paragraphs and you 
realize that you’re going need to do this again throughout your document. Rather than finding 
the same key again, in this case, the border style that I’ve used throughout this document, 
highlight the font you want and hit CTRL Y. 

CTL-W close file (works for Chrome tabs too) 

If you prepare reports like I do, after you’ve been working for a long time, you’ll probably 
have a dozen or so files open and likely lots of tabs too. If your computer is slowing down, or 
you’re reaching a deadline, now would be a good time to ALT TAB through the various 
applications you have running and start closing a few windows. This will enable your computer 
to run more efficiently and allow you to focus on wordsmithing your document.  

After  

ALT-CTL-PRT SC – print screen 

One of the handiest keystroke combinations I learned just prior to authoring this document 
is ALT CTRL PRT SC. Typically PRT SC can be found on the F10 key, or thereabouts, and 
is used to capture a static image of what you’re presently seeing on your computer screen(s). 
The problem with simply using PRT SC rather than ALT CTL PRT SC is that if you have 
multiple screens you will likely end up with unwanted data that you have to crop (Figure 2). 

  
Figure 2. Left window is the result of PRT SC. Right window is the result of CTRL ALT PRT SC. 
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5. Built for Speed – Quit Mousing Around! 
This chapter’s purpose is to help you end your mouse addiction. When I purchased my first 

laptop from a friend in 1996, the laptop’s mousepad was broken. To do anything on this 486 
machine, I was forced to use the keypad for everything. Fortunately, the Windows operating 
system was designed to allow users to do just about anything and everything with the right 
combination(s) of keystrokes on the keypad. Here are a few that I use regularly and indeed as 
second nature to keep me from caving into the temptation of going for that mouse or 
mousepad every time I want to move the cursor, select text, or perform another routine 
command.  

fn › go to end of line (function rightarrow) 

You’re typing along and you see some text at the end of your paragraph or line that you 
need to get rid of, or you have a set of characters in your clipboard memory that you need to 
paste at the end of a line. Don’t fumble for the mouse or carefully try to position your cursor at 
the exact end of your line or paragraph, risking a click in the wrong place. Instead, depress the 
fn key with your left ring finger and the › key with your right ring finger. Bam! The cursor is 
exactly where you wanted it. Please note that I am distinguishing between the > (greater than 
sign) on the . (period) key and the › (rightarrow) key, which is typically found in the bottom 
right corner of your keypad.  

fn ‹  go to beginning of line (function leftarrow)  

As you might have guessed, the same trick we just learned above, works in reverse. Hit 
fn ‹ to instantly position your cursor at the beginning of a line. Once your cursor has arrived 
precisely at its intended destination, you are ready to continue navigating precisely through 
your document. 

SHIFT › or SHIFT ‹ grabs single characters one at a time 

Just as we learned with fn-›, using the SHIFT key(s) with the left and right arrows allows 
you to highlight and manipulate format, etc., single characters. This set of keystrokes is   
SHIFT - ↓ or SHIFT - ↑ Grab multiple lines quickly. uparrow downarrow 

ALT-S-F Insert Footnote 
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Figure 3. To insert a footnote, hit ALT, S, F in order.  

ALT-S  macro: format as symbol, e.g. W -> Ω, m -> µ, etc. 

Use CTL C followed by CTL V on a figure caption to quickly embed the autonumbering 
feature of figure captions and table captions in new figures and tables. 

Superscript and Subscript  

To turn a character into a superscript, such as with x2, first highlight it with SHIFT › or 
SHIFT ‹, then 

CTL SHIFT + to get a superscript 

CTL SHIFT = to get a subscript 

CTL-leftmouse to get to a location in document followed by alt-leftarrow to get back 

Let’s say you are looking for a particular spot in your document. You go the Table of 
Contents and find the topic you want. Rather than left-clicking, use CTRL leftmouse to get 
where you want. Once you’re done, you can use ALT ‹. 

Clickbait – Double-Click and Triple-Click to Precisely control text selection. 

Double click a word to highlight the entire word. 

Triple click within a paragraph to highlight the entire paragraph.  

Add macros to limit mouse time 

For example, I have defined CTRL 6 for green, ALT D for degree,  °, and  ALT S for 
symbol. Symbol, by the way, is super-handy for adding Greek letters.



Pro Formatting  Page 7 of 25 

6. Pro Formatting 1 

The Ruler Rules! 2 

Use the ruler to define your styles as you begin laying out your document, and to clean it up 3 
at the end. 4 

If you’re in Microsoft Word and you don’t see the ruler, go to View → Show and check Ruler 5 
(Figure 4). 6 

 7 
Figure 4. Be sure to turn on the Ruler whenever you are verifying indents and verifying, inserting or 8 
adjusting tabs.  9 

Take advantage of the hanging indent for references. 10 

 11 
Figure 5. Notice how I use a 0.5′′ hanging indent to format the refences as is standard for most reference 12 
styles. Note also how EndNote™ takes care of alphabetization for me. 13 
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Vertical Spacing 1 

When formatting your styles, it is typically bad practice to add space below lines. Instead 2 
add space above lines. 3 

    4 
Figure 6. In the image on the left, Spacing is set to 0 pt before and 10 pt After. Instead, change this 5 
to 0 pt After and an appropriate value for Before as seen in the image on the right. 6 

A Font of Fonts at your Fingertips 7 

Lately I’ve been using Courier New for my expert witness reports, as this is the font I 8 
frequently see in other legal documents. Courier New maintains the same number of pixels 9 
per character, so a period and a W occupy the same space horizontally along the page. Another 10 
rule of thumb for fonts is to use a serifed font such as Times New Roman for documents that 11 
are going to be physically printed, and a sans serif font such as Calibri for documents that are to 12 
be viewed on a computer screen. 13 

CTRL D to bring up the Font Menu 14 

To bring up the font menu, hit CTRL D and select your font of choice from the menu. 15 
Don’t go overboard with this. Use a serifed font like Times New Roman for the body and a sans-16 
serif such as Calibri for tables and figures. As I mention above, It is also common for legal 17 
documents to use Courier New. 18 

Styles: body, body_no_indent, figure, caption, quote, heading 19 

The styles listed in this section’s title are used in this document. There really is no limit to 20 
the number of styles you can define. My advice here is to find a set of styles you like and stick 21 
with it, using a well-formatted report as a style template for future reports.  22 

When transitioning from one style to the next, you’ll note that this is typically done 23 
between ¶ symbols after using your CTRL SHIFT 8 command you’ll learn below. If you have 24 
a style you like and want a subsequent paragraph to inherit the same style, when hit return at 25 
the end of a paragraph, the new or existing subsequent paragraph inherits the style of the 26 
preceding paragraph. 27 

CTRL SHIFT HYPHEN to keep a hyphenated word from breaking across lines 28 

Ever have a compound adjective that you want to clearly display as a compound adjective? 29 
Rather than leaving a line break as ambiguous, keep the text preceding and following the 30 
hyphen together by using CTRL SHIFT -.   31 
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CTRL SHIFT SPACE to keep a phrase from breaking between lines 1 

Ever have a phrase such as “55 mph” that looks better on a single line, but it breaks 2 
between lines? To keep the “55” with the “mph,” hit CTRL SHIFT SPACEBAR to keep 3 
55 mph as a single entity on the same line. 4 

Home → Paragraph → Keep with next to keep lines together 5 

This is one of my main go-tos in report formatting, especially when it comes to keeping a 6 
heading with the paragraph that follows it. To do so, follow the menus of Figure 7 or use the 7 
keystroke sequence alt → H → PG → P → tab → tab → spacebar → enter. 8 

 9 
Figure 7. In this screenshot, we see the sequence of Home -> Paragraph -> Line and Page Breaks -> Keep 10 
with Next, which ensures that the text preceding equation (2) appears on the same page as equation (2). 11 

In fact, when preparing this very subsection, I used Home → Paragraph → Keep with next to 12 
keep the paragraph preceding Figure 7 on the same page as Figure 7. 13 

Home -> Paragraph -> Indents and Spacing → Spacing → Before to add consistent spacing 14 
before various Styles 15 

This subtle, but critical pro formatting maneuver serves several purposes. First, it makes 16 
your report more readable by making the styles more predictable. Predictability facilitates 17 
visual searching by the attorney or paralegal who will be scanning your report for key 18 
information. By making this formatting change early in authoring your report, and then saving 19 
this to a Style, you won’t have to worry about the formatting later as you’re writing, leaving you 20 
to simply get your thoughts into your report. Also, once you’ve committed to a spacing for 21 
Styles like body, figure, Heading 1, Heading 2, caption, etc. and need to change something later, 22 
you can easily do this by changing it once in a particular instance of a given Style, then selecting 23 
the dropdown in the Styles menu, hovering over the appropriate Style, right clicking, and 24 
selecting Update Style to Match Selection.  25 
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Section Breaks – Layout → Breaks → Section Break → Next Page 1 

Section Breaks are among the most powerful formatting tools at your disposal as you 2 
prepare your document for submission. To add a new section that begins on the next page, 3 
follow the instructions in Figure 8 . 4 

 5 
Figure 8. To enter a section break that begins on the next page, go to Layout → Breaks → Next 6 
Page. 7 

The ALT sequence for this is ALT → P → B → N. 8 

Line numbering 9 

In addition to page numbering, which all of your expert witness reports must have, it is also 10 
advisable to add line numbers to your report.  11 

Be sure that when you are adding line numbers that you start each new page with new line 12 
numbers beginning with “1.” 13 

To keep the line numbers from stealing the show, grey them out by going into the little 14 
right-diagonal down-arrow in the bottom right corner of the Home → Styles menu (Figure 5). 15 

 16 



Pro Formatting  Page 11 of 25 

Figure 9. Find “Line Number” under the bottom-right down-right arrow at the bottom of the Home → 1 
Styles menu and select a gray font so that the line numbers do not overwhelm the body text.. 2 

After you’ve found Line Number, right-click and select Modify, then select gray as the font color (Figure 3 
6). 4 

 5 

Figure 10. Once you’ve found the font menu under “Modify” after right-clicking on the Line Number 6 
style, you should have the option to change the Font color to gray. 7 

Page numbering 8 

My preference in page numbering is to include page numbers in the format of “Page x of y” 9 
as I’ve done in this document. I typically right-justify the page numbers, which leaves the left 10 
side of the footer available for the section name. 11 

 12 
Figure 11. Note how there are two tabs between the section name and the page number in the footer. 13 
Note that there are two corresponding tabs: one center and one right in the ruler. The center tab may be 14 
superfluous, but the second tab ensures that the  15 
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Inserting bookmarks 1 

Bookmarks allow you to have control over the symbols you choose to represent a given 2 
portion of your report. For example, for a report that uses equations, you might wish to 3 
reference a given equation number. Rather than manually entering an equation number that is 4 
likely to change as you update your document, insert a bookmark. As the numerical value of the 5 
equation changes, the bookmark text will also be updated. 6 

 7 
Figure 12.  First highlight the text that you want to appear when you cross-reference your bookmark. 8 
Here I have highlighted the number 6 and both parentheses on either side of it so that when I insert a 9 
cross-reference to this particular bookmark, all three characters “(6)” will appear. 10 

After you have selected the text that you wish to be represented by your bookmark, name 11 
your bookmark .  12 

 13 

Figure 13.  Name your bookmark. Note that bookmark names may not include spaces. 14 

 15 
Figure 14. Go to Insert → Cross-reference  → Reference type  → Bookmark, and select your bookmark. 16 
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The text associated with your bookmark will appear in the location you selected. 1 

Later, if you add another equation, (6) will advance to (7) as will any cross references to this 2 
equation. 3 

Removing Formatting with Notepad 4 

 5 
Figure 15. Copy and paste text into Notepad to remove unwanted formatting. 6 

A few built-in MS Word formatting features 7 

Copyright© and trademark™ are a couple of built-in formatting hacks built into MS Word. 8 
To get these two superscripted symbols after a particular word, simply type a left paren before 9 
and a right paren after, and the symbols appear.  10 
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7. EndNote 
I discovered EndNote in graduate school. If you haven’t tried it and are still using manual 

citation entries, and have more than ten [10] references in your report(s), it’s time you loaded 
EndNote on your computer. 

The handiest key for EndNote is alt-2. alt-2 allows you to instantaneously add a fully 
formatted citation and its associated bibliography entry. 

Watch this video on how quickly this works. 

 
Figure 16.  With the reference you would like to enter and your cursor  placed in the place you would like 
it in MS Word, hit alt-2, and your reference appears in the specified format in the desired location. 
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Figure 17.  the citation, (McConnell and Xiao 2022) appears where the cursor was placed after alt-2 is 
pressed from inside either the EndNote application or the MS Word application. 

One feature of EndNote™ that I use extensively is its citation editing feature. I particular, 
when making a citation to a reference, and I want to use the author’(s’) name(s) in the 
sentence, I will use the dropdown by right-clicking on the citation and selecting exclude Author 
name 

 
Figure 18. To exclude author names from a citation, select Edit Citation(s) → Exclude Author 
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8. Making it Pop 

Exercise 

Write a macro to add a border to an embedded image. 

Footers 

Be very careful with putting cross-references to headings in your footer. This can lead to 
“page bloat.” Instead consider hard-typing footer content. 
Index 

To turn off Index entries in the body of your report, Try File → Options →  Display  →  Hidden text  

 
Figure 19. Turn off hidden text 
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9. Cleaning It UP 

CTL-SHIFT-8 

This little-known but highly coveted skill will help you solve many of the mysteries of MS 
Word that have likely been plaguing you. 

By hitting ctl-shift-8, you will be able to toggle between seeing and not seeing the 
formatting characters such as space, tab, and paragraph return. 
Left click then right click on a Figure number or Table number to bring up the update menu 

 
Figure 20. The “1” in Table 1 is highlighted after a left click. A right click brings up a menu which includes 
Update Field. 

Updating your Autonumbering with Naughty Number Nine – the F9 key 

Start with a CTL – A to select the entire document, then hit F9 (usually just above the 8 key). 
T 

F9 not working? 
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Figure 21. If F9 is not working to update autonumbering and hyperlinks in your document, bring up the 
On-Screen Keyboard. 

View Management 
Double-click the page break 

  
Figure 22. Notice how the right image removes nearly all the whitespace at the bottom of the top page 
and the top of the bottom page. 

Double click the page break again. 
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Figure 23. Notice how the right image removes nearly all the whitespace at the bottom of the top page 
and the top of the bottom page. 
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10. Windows Management 

Split Screen coupled with hidden header and footer 
When working within a complex document, it is frequently desirable to be able to view two portions of 
the document simultaneously. For example, you may want to be viewing the table of contents along 
with the body of the document, or the reference section along with the body of the document. 

 

Figure 24. Go to View →Split to split the window. 

 

ALT-SPACEBAR 

ALT-SPACEBAR brings up a menu with six [6] commands 

 
Figure 25. ALT-SPACEBAR brings up a handy menu for manipulating a window. Use this if you’re having 
mouse issues. 
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Split the screen with   › 

This set of keystrokes will justify the windows on your screen. For example, you may be 
reading a pdf and editing in MS Word and want to have both windows as large as possible 
without wasting valuable pixels on other windows you are not using. With  ›, or 
combinations of  › ˅. See Figure 25 for an example of what this window organization looks 
like. 

 
Figure 26. In this image, we can see that we are using the entire left half of the screen for Adobe and the 
entire right half of the screen for MS Word. 

You will also see that by hovering over the “maximize” icon in the upper right corner of a 
window that you can select its location on the particular screen you are working on (Figure 26). 



Windows Management  Page 22 of 25 

 

Figure 27. For this particular window, I wanted it to appear in the lower half of the screen so I selected 
the lower pane of the top left option. 
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Where’s my mouse pointer anyway? 

Set up your laptop to highlight the cursor whenever you hit the CTRL key. To turn on this 
feature, go to  → Settings, etc., as seen in Figure 26. 

 
Figure 28. To turn on the cursor locator on your system, go to  → Settings → Bluetooth & devices →  
Mouse → Additional mouse settings → Mouse Properties → Show location of pointer when I press the 
CTRL key.  
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11. Further References 
One of the best references I have encountered for general report preparation is Tufte’s 

“Visual Display of Quantitative Information” (Tufte 2001). 

SEAK also has excellent references that include finer details on expert witness report 
content, e.g. (Mangraviti, Babitsky and Donovan 2014), as well as a course by a 
similar title.2 

I have also relied upon a book by Jeter and Donnell (2016) 

 
2 https://store.seak.com/how-to-write-a-bulletproof-expert-witness-report-june-6-7-2023-live-via-
zoom/?showHidden=true  

https://store.seak.com/how-to-write-a-bulletproof-expert-witness-report-june-6-7-2023-live-via-zoom/?showHidden=true
https://store.seak.com/how-to-write-a-bulletproof-expert-witness-report-june-6-7-2023-live-via-zoom/?showHidden=true
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